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the maximum return on your time. You’ll focus on the tasks and skills that increase
productivity while working at your own pace and convenience.

We invite you to visit the Perspection web site at:

www.perspection.com
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Please note that I cannot help you with technical problems related to the topic 
of this book. We do have a User Services group, however, where I will forward spe-
cific technical questions related to the book.
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ments and share them with the author and editors who worked on the book.

Email: feedback@quepublishing.com
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Introduction

Welcome to Word 2013 on Demand, a visual quick reference
book that shows you how to work efficiently with Microsoft
Word.  This book provides complete coverage of basic to
advanced Word skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Word 2013, just look for
the icon: New!. The new icon appears in the table of contents
and throughout this book so you can quickly and easily iden-
tify a new or improved feature in Word 2013. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P, as a quicker alternative to using the mouse. A com-
plete list of keyboard shortcuts is available on the web at
www.queondemand.com or www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Microsoft Office Specialist

Get More on the Web

http://www.queondemand.com
http://www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the web at
www.queondemand.com or
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

http://www.queondemand.com
http://www.perspection.com


The Workshops
walks you
through in-depth
projects to help
you put Microsoft
Word to work.

Introduction xix

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshops. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the web at
www.queondemand.com or
www.perspection.com.

Microsoft Office
Specialist
This book prepares you for the
Microsoft Office Specialist (MOS)
exam for Microsoft Word 2013.
Each MOS certification exam has a
set of objectives, which are organ-
ized into broader skill sets. To pre-
pare for the MOS certification
exam, you should review and per-
form each task identified with a
MOS objective to confirm that you
can meet the requirements for the
exam. Information about the MOS
program is available in the back of
this book. The MOS objectives and
the specific pages that cover them 
are available on the web at
www.queondemand.com or
www.perspection.com.

http://www.queondemand.com
http://www.perspection.com
http://www.queondemand.com
http://www.perspection.com
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the web to help
you get up to speed faster with
Word 2013. Some of the informa-
tion includes: 

Transition Helpers
◆ OOnnllyy  NNeeww  FFeeaattuurreess..

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ KKeeyybbooaarrdd  SShhoorrttccuuttss..

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ PPhhoottooggrraapphhss.. Download

photographs and other
graphics to use in your Office
documents. 

◆ MMoorree  CCoonntteenntt.. Download
new content developed after
publication. For example,
you can download a chapter
on SharePoint server and
Office 365.

You can access these additional
resources on the web at
www.perspection.com.

Additional content 
is available on the
web. You can
download keyboard
shortcuts.

http://www.perspection.com


Formatting Documents

Introduction

Once you type a document and get the content how you
want it, the finishing touches can sometimes be the most
important. An eye catching document will draw the reader in,
while a boring font without a lot of extra details will draw the
reader away from all your hard work. To create that interest,
Microsoft Word can help you change your document for a
fresh look. One of the first elements you can change is your
font attributes. Applying bold, underline, or italics when
appropriate, can emphasize text. You might find that having
different font sizes in your document to denote various topics
will also enhance your document.

You can change the kkeerrnniinngg—the amount of space
between each individual character, for a special effect on a
title or other parts of text. You can also apply a dropped capi-
tal letter to introduce a body of text, add a shading or border
onto your document.

Word has various tools to help you format your docu-
ment. You can search and replace formatting effects, display
rulers, change a paragraph alignment, set paragraph tabs
and indents, and change your line spacing. There are times
when typing a paragraph will not do your text justice.
Creating a bulleted or numbered list might better show your
information. To further enhance the appearance of the text in
a paragraph, you can quickly add a border and shading to
selected text. If you have confidential information in a docu-
ment or text that you don’t want others to see, you can use a
formatting option to hide the text. 3

3
What You’ll Do

Format Text

Format Text for Emphasis

Select Text with Similar Formatting

Set Formatting Options

Find and Replace Formatting

Find and Replace Custom Formatting

Change Paragraph Alignment

Change Line Spacing

Change Character Spacing

Display Rulers

Set Paragraph Tabs

Set Paragraph Indents

Create Bulleted and Numbered Lists

Apply Borders and Shading

Hide Text
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A font is a collection of alphanumeric characters that share the same
typeface, or design, and have similar characteristics. You can format
text and numbers with font attributes—such as bolding, italics, or
underlining—to enhance data to catch the reader’s attention. The main
formats you apply to text are available on the Home tab in the Font
group or in the Font dialog box. Some of the formats available include
strikethrough, subscript, superscript, and underline style and color.
When you point to selected text, Office displays the Mini-Toolbar above
it. The Mini-Toolbar provides easy access to common formatting tool-
bar buttons, such as font, font size, increase and decrease font size,
bold, italic, font color, increase and decrease list level, and styles
(New!). If you don’t want to display the Mini-Toolbar, you can use
Word Options to turn it off. 

32

Formatting Text

Format Text Quickly

Select the text you want to format.

Click the Home tab.

To change fonts, click the Font list
arrow on the Ribbon or Mini-
Toolbar, and then point for a live
preview, or click the font you want,
either a theme font or any available
fonts.

The font name appears in the font
style.

To change the font size, click one
or more of the font size buttons on
the Ribbon or Mini-Toolbar:

◆ Click the Font Size list arrow,
and then click the font size 
you want.

◆ Click the Increase Font Size
button or Decrease Font Size
button.

To apply other formatting, click one
or more of the formatting buttons
on the Ribbon or Mini-Toolbar:
Bold, Italic, Underline, Shadow,
Strikethrough, or Font Color.

◆ To select an underline style,
click the Underline button
arrow, and then select a style 
or color. 

3

2

1

1

Mini-Toolbar
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Format Text Using the Font
Dialog Box

Select the text you want to format.

Click the Home tab.

Click the Font Dialog Box
Launcher.

The Font dialog box opens,
displaying the Font tab.

Select the font, font style, and font
size you want.

If you want, click the Font Color
list arrow, and then click a color. 

If you want, click the Underline list
arrow, click a style, click
Underline Color list arrow, and
then click a color.

Click OK.7

6

5

4

3

2

1

32

1

75

4

6

Preview box

Did You Know?
You can tell the difference between a
TrueType and printer font. A TrueType
(outline) font is a font that uses special
software capabilities to print exactly
what is seen on the screen. A printer
(screen) font is a font that comes only
in specified sizes. If you are creating a
document for publication, you need to
use printer fonts.

What is a point? The size of each font
character is measured in points (a
point is approximately 1/72 of an inch). 

Each computer has different fonts
installed. Users with whom you share
files may not have all the fonts you’ve
used in a document installed on their
computers. 
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1

2 3

5

4

6 All caps and highlighted text

If you want to add emphasis or style to text in a document, you can
apply text formatting. In addition to the standard formatting options—
Bold, Italic, Underline, etc.—Word provides additional text formatting,
including Color, Gradient, Strikethrough, Superscript, Subscript, and
Highlight, as well as enhanced text effects, including presets, Outline,
Shadow, Reflection, Glow, Number Styles (New!), Ligatures (New!)
(letter spacing), and Stylistic Sets (New!). In the Font dialog box, you
can apply even more effects, including 3-D formatting. To help you for-
mat sentences and change capitalization, you can change text case. 

Formatting Text for
Emphasis

Apply Formatting Text Effects

Select the text you want to format.

Click the Home tab.

Click the formatting (Font, Font
Style, Size, Bold, Italic, Underline
(select a style and color), Strike-
through, Superscript, Subscript, or
Font Color (select a color or a
Gradient) you want.

To add a visual effect to text, click
the Text Effect button, and then
click a preset effect or an option:

◆ Outline
◆ Shadow
◆ Reflection
◆ Glow
◆ Number Styles (New!) 
◆ Ligatures (New!) 
◆ Stylistic Sets (New!) 

To change text case, click the
Case button, and then click the
option you want:

◆ Sentence case.
◆ lowercase
◆ UPPERCASE
◆ Capitalize Each Word
◆ tOGGLEcASE

To highlight text, click the
Highlight button arrow, and then
click the color you want.

◆ Add highlight. Click a color.
◆ Remove highlight. Click No

Color.

6

5

4

3

2

1 Applied style
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Apply Other Formatting Effects 
to Text

Select the text you want to format.

Click the Home tab.  

Click the Font Dialog Box
Launcher.

Click the formatting (Font, Font
style, Size, Font color, Underline
style, and Underline color) you
want.

Click to select the effects (Strike-
through, Double strikethrough,
Superscript, Subscript, Small
caps, All caps, and Hidden) you
want.

To custom text effects, such as a
text fill or outline with a solid or
gradient, shadow, reflection, glow
and soft edges, or 3-D format, click
Text Effects, click the Text Fill &
Outline (New!) or Text Effects
(New!) button, expand options as
needed, specify the options you
want, and then click OK. 

Check the results in the Preview
box.

To make the new formatting
options the default for all new
Word documents, click Set As
Default, and then click Yes.

Click OK.9
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Did You Know?
You can quickly clear formatting.
Select the text to which you want to
clear formatting, click the Home tab,
and then click the Clear Formatting
button.

Strikethrough textText effect

6

All caps and highlighted text

Text effects
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A quick way to select text with similar formatting is to use the Select
Text with Similar Formatting command. After you select the text with
the formatting you want to find, click the Select button on the Home
tab, and then choose the Select Text with Similar Formatting command.
Word highlights all the text with similar formatting in the document.
With the text selected, you can change the text formatting.

Selecting Text with
Similar Formatting

Select Similar Text Formatting

Select the text you want to find.

Click the Home tab.

Click the Select button, and then
click Select Text with Similar
Formatting.

3

2

1
2

3

1

Did You Know?
You can quickly clear formatting.
Select the text to which you want to
clear formatting, click the Home tab,
and then click the Clear Formatting
button. 

See Also
See “Revealing Formatting Styles” on
page 96 for more information on using
the Select Text With Similar Formatting
command.

Selected results
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When you work within a document, you can set options to customize
the way formatting appears in Word. In Word Options on the Display
pane, you can set options to show or hide formatting marks. Formatting
marks help you see characters that are not visible, such as tabs,
spaces, paragraph marks, and hidden text. On the Advanced pane, you
can set options to keep track of formatting (in the Style Inspector and
direct formatting) and mark formatting inconsistencies, so you can cre-
ate consistently formatted documents. When you cut, copy, and paste
text and objects within the same document, between documents, or
other programs, you can set options to keep source formatting or
merge formatting with the current selection.

Setting Formatting
Options

Change Formatting Options

Click the File tab, and then click
Options.

In the left pane, click Display.

Select or clear any of the check
boxes to display or hide the
formatting marks you want.

◆ Tab characters, Spaces,
Paragraph marks, Hidden text,
Optional hyphens, or Object
anchors. (Default off).

◆ Show all formatting marks.
(Default off).

In the left pane, click Advanced.

Select or clear any of the check
boxes.

◆ Keep track of formatting.
(Default off).

◆ Mark formatting
inconsistencies. (Default off).

Select formatting options for when
you cut, copy, and paste text and
objects within the same document,
between documents, or other
programs.

◆ Keep Source Formatting
(Default).

◆ Merge Formatting.

Click OK.7
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Suddenly you realize all the bold text in your report would be easier to
read in italics. Do you spend time making these changes one by one?
No. The Find and Replace feature locates the formatting and instantly
substitutes new formatting. If your search for a formatting change is an
easy one, click Less in the Find and Replace dialog box to decrease the
size of the dialog box. If your search is a more complex one, click More
to display additional options. With the Match Case option, you can spec-
ify exact capitalization. The Reading Highlight button highlights items
found to make them easier to read. The Go To tab quickly moves you to a
place or item in your document. You can search for an item, such as
bookmark or comment, or location, such as a page or section.

Finding and 
Replacing 
Formatting

Find Formatting

Click the Home tab.

Click the Find button arrow, click
Advanced Find, and then click
More to expand the dialog box.

To clear any previous settings,
click No Formatting.

If you want to locate formatted
text, type the word or words.

Click Format, and then click the
formatting you want to find.

To highlight located items, click
Reading Highlight, and then click
Highlight All.

Click Find Next to select the next
instance of the formatted text.

Click OK to confirm Word finished
the search.

Click Close or Cancel.9
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21 Current find settings

4

7

6

3
Switches from

More to Less

Did You Know?
You can find an item or location.
Click the Home tab, click the Find but-
ton arrow, click Go To, click an item to
find, enter an item number or name,
click Next, Previous, or Go To to locate
the item, and then click Close.
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Replace Formatting

Click the Home tab.

Click the Replace button, and then
click More to expand the dialog
box.

If you want to locate formatted
text, type the word or words. 

Click Format, and then click the
formatting you want to find. When
you’re done, click OK.

Press Tab, and then type any text
you want to substitute.

Click Format, and then click the
formatting you want to substitute.
When you’re done, click OK.

To substitute every instance of the
formatting, click Replace All. 

To substitute the formatting one
instance at a time, click Find Next,
and then click Replace.

If you want to cancel the replace,
click Cancel.

If necessary, click Yes to search
from the beginning of the
document. 

Click OK to confirm Word finished
searching.

Click Close or Cancel.10
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Did You Know?
You can find and replace special char-
acters and document elements.
In Word, you can search for and
replace special characters (for exam-
ple, an em dash) and document ele-
ments (for example, a tab character).
Click More in the Find And Replace
dialog box, click Special, and then click
the item you want from the menu.
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If your search for formatting involves a complex search for a specific
type of formatted text, click More in the Find and Replace dialog box to
increase the size of the dialog box and display additional options. The
expanded Find and Replace dialog box provides options to find exact
capitalization, find whole words only, use wildcards, and locate words
that sound like English or different forms of English words. With the
Special button, you can find and replace special characters and ele-
ments, such as graphics, tabs, fields, white space, and page breaks. 

Finding and Replacing
Custom Formatting

Find or Replace Special
Formatting

Click the Home tab.

Click the Find button arrow, and
then click Advanced Find or click
the Replace button.

To clear any previous settings,
click No Formatting.

If you want to locate formatted
text, type the word or words you
want to find and/or replace.

Click More to expand the dialog
box.

Click Special, and then click the
specialized formatting item you
want to find.

Click Find Next to select the next
instance of the formatted text.

To substitute every instance of the
formatting, click Replace All. 

To substitute the formatting one
instance at a time, click Find Next,
and then click Replace.

Click OK to confirm Word finished
the search.

Click Close or Cancel.10
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Switches from More to Less5
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Use Find and Replace Options

Click the Home tab.

Click the Find button arrow, and
then click Advanced Find or click
the Replace button.

To clear any previous formatting
and settings, click No Formatting.

If you want to locate formatted
text, type the word or words you
want to find and/or replace.

Click More, and then select or
clear the options you want:

◆ Search. Select a search
direction: All, Down, or Up.

◆ Match Case. Select to find
exact capitalization.

◆ Find whole words only. Select
to find words with space on
either side.

◆ Use wildcards. Select to use
wildcards, such as asterisk (*)
or question mark (?).

◆ Sounds like (English). Select to
find English sounding words.

◆ Find all word forms (English).
Select to find all English forms
of a word.

◆ Match prefix or Match suffix.
Select to find text at the
beginning or end of a word.

◆ Ignore punctuation characters
or Ignore white-space
characters. Select to ignore
punctuation (periods, commas,
etc.) or white space
characters.

Click Find Next to select the next
instance of the formatted text, or
click Replace

Click OK to confirm Word finished
the search.

Click Close or Cancel.8
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Switches from
More to Less5

Using Wildcards

A wildcard allows you to search for variable text.  For example, you
can use the asterisk (*) wildcard to search for a string of characters
("s*d" finds "sad" and "started"), or use the question mark (?) wildcard to
search for any single character (s?t finds "sat" and "set"). To search for
a character that's defined as a wildcard, type a backslash (\) before
the character. For example, type \? to find a question mark. 

For Your Information
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Text starts out positioned evenly along the left margin, and uneven, or
ragged, at the right margin. Left-aligned text works well for body para-
graphs in most cases, but other alignments vary the look of a document
and help lead the reader through the text. Right-aligned text, which is
even along the right margin and ragged at the left margin, is good for
adding a date to a letter. Justified text spreads text evenly between the
margins, creating a clean, professional look, often used in newspapers
and magazines. Centered text is best for titles and headings. You can
use Click-And-Type to quickly center titles or set different text align-
ment on the same line, or you can use the alignment buttons on the
Home tab to set alignment on one or more lines.

Changing Paragraph
Alignment

Align New Text with 
Click-And-Type

◆ Position the I-beam at the left,
right, or center of the line where
you want to insert new text.

When the I-beam shows the
appropriate alignment, double-
click to place the insertion point,
and then type your text. 

Align Existing Text

Position the I-beam, or select at
least one line in each paragraph to
align.

Click the appropriate button on the
Home tab. 

◆ Align Left button 

◆ Center button 

◆ Align Right button 

◆ Justify button  

2

1

Pointer Purpose

Left-aligns text

Right-aligns text

Centers text

Creates a new line in the same paragraph

Creates a text around a picture

1

2

Click-And-Type Text Pointers
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The lines in all Word documents are single-spaced by default, which is
appropriate for letters and most documents. But you can easily change
your document line spacing to double or 1.5 lines to allow extra space
between every line. This is useful when you want to make notes on a
printed document. Sometimes, you’ll want to add space above and
below certain paragraphs, for headlines, or indented quotations to help
set off the text.

Changing Line 
Spacing

Change Line Spacing

Select the text you want to
change.

Click the Home tab.

Click the Line Spacing button
arrow, and then click a spacing
option.

◆ To apply a new setting, click
the number you want.

◆ To apply the setting you last
used, click the Line Spacing
button. 

◆ To enter precise parameters,
click Line Spacing Options,
specify the line or paragraph
settings you want, and then
click OK.

◆ To apply the setting you last
used, click Add Space Before
Paragraph or Add Space After
Paragraph. 

TIMESAVER Press Ctrl+1 for
single-spacing, Ctrl+5 for 1.5
spacing, or Ctrl+2 for double-
spacing.
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32

Line Spacing Options
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Kerning is the amount of space between each individual character that
you type. Sometimes the space between two characters is larger than
others, which makes the word look uneven. You can use the Font dialog
box to change the kerning setting for selected characters. Kerning
works only with OpenType/TrueType or Adobe Type Manager fonts. You
can expand or condense character spacing to create a special effect
for a title, or re-align the position of characters to the bottom edge of
the text—this is helpful for positioning the copyright or trademark sym-
bols. In addition, you can set text formatting for OpenType/TrueType
fonts that include a range of ligature settings (where two or three let-
ters combine into a single character), number spacing and forms, and
stylistic sets (added font sets in a given font). Many of these options
are based on specifications from font designers.

Changing Character
Spacing

Change Character Spacing

Select the text you want to format.

Click the Home tab.

Click the Font Dialog Box
Launcher.  

Click the Advanced tab.

Click the Spacing list arrow, click
an option, and then specify a point
size to expand or condense
spacing by the amount specified.

Click the Position list arrow, click
an option, and then specify a point
size to raise or lower the text in
relation to the baseline (bottom of
the text). 

Select the Kerning for fonts check
box, and then specify a point size.

To make the new formatting
options the default for all new
Word documents, click Set As
Default, and then click Yes.

Click OK.9
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Preview
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Change OpenType Features

Select the text you want to format.

Click the Home tab.

To set quick OpenType options,
click the Text Effects button, point
to Number Styles (New!),
Ligatures (New!), or Stylistic Sets
(New!), and then select an option.

To set advanced options, click the
Font Dialog Box Launcher.  

Click the Advanced tab.

Click any of the follow list arrows,
and then select an option:

◆ Ligatures. Select Standard Only
(current standard), Standard
and Contextual (current
standard plus font specific
additions), Historical and
Discretionary (old standard), 
or All.

◆ Number Spacing. Select
Default (specified by font
designer), Proportional (varying
width spacing), or Tabular
(same width spacing).

◆ Number Forms. Select Default
(specified by font designer),
Lining (same height, not below
base-line), or Old-Style (flow
above or below the line of text).

◆ Stylistic Sets. Select Default
(specified by font designer) or a
specific set number.

Select the Use Contextual
Alternates check box to provide
fine-tuning of letters or letter
combinations based on the
surrounding characters.

To make the new formatting
options the default for all new
Word documents, click Set As
Default, and then click Yes.

Click OK.9
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Word rulers do more than measure. The horizontal ruler above the doc-
ument shows the length of the typing line and lets you quickly adjust
left and right margins and indents, set tabs, and change column widths.
The vertical ruler along the left edge of the document lets you adjust
top and bottom margins and change table row heights. You can hide
the rulers to get more room for your document. As you work with long
documents, use the document map to jump to any heading in your doc-
ument. Headings are in the left pane and documents in the right. 

Displaying Rulers

Show and Hide the Rulers

Click the View tab.

Select or clear the Ruler check
box.

◆ To view the horizontal ruler,
click the Web Layout View or
Draft View button.

◆ To view the horizontal and
vertical rulers, click the Print
Layout View button.

2

1
12

Did You Know?
You can change the ruler measure-
ments. Change the ruler to show
inches, centimeters, millimeters,
points, or picas. Click the File tab, click
Options, click Advanced, click the
Show Measurement In Units list arrow,
select the measurement you want, and
then click OK.

You can set your text to be hyphen-
ated. Hyphenation prevents ugly gaps
and short lines in text. Click the Page
Layout tab, click the Hyphenation but-
ton, and then click None, Automatic, or
Manual, or Hyphenation Options. Click
Hyphenation Options to set the
hyphenation zone and limit the number
of consecutive hyphens (usually two),
and then click OK.
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In your document, tabs set how text or numerical data aligns in relation
to the document margins. A tab stop is a predefined stopping point
along the document’s typing line. Default tab stops are set every half-
inch, but you can set multiple tabs per paragraph at any location.
Choose from four text tab stops: left, right, center, and decimal (for
numerical data). The bar tab inserts a vertical bar at the tab stop. You
can use the Tab button on the horizontal ruler to switch between the
available tabs.

Setting Paragraph
Tabs

Create and Clear a Tab Stop

Select one or more paragraphs in
which you want to set a tab stop.

Click the Tab button on the
horizontal ruler until it shows the
type of tab stop you want.

Click the ruler where you want to
set the tab stop.

If necessary, drag the tab stop to
position it where you want.

To display a numerical
measurement in the ruler where
the tab is placed, press and hold
Alt as you drag.

To clear a tab stop, drag it off the
ruler.
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1

Tab Stop Purpose

Aligns text to the left of the tab stop

Aligns text to the right of the tab stop 

Centers text on the tab stop                 

Aligns numbers on the decimal point

Inserts a vertical bar at the tab stop

1

32
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Tab Stops

Did You Know?
You can view formatting marks.
Sometimes it’s hard to see the number
of spaces or tabs between words. You
can change the view to display format-
ting marks, a period for space and an
arrow for tabs. Click the Home tab, and
then click Show/Hide ¶ button to toggle
on and off. Click the File tab, click
Options, click Display, select the for-
matting mark check boxes you want to
view, and then click OK.
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Quickly indent lines of text to precise locations from the left or right
margin with the horizontal ruler. Indent the first line of a paragraph
(called a first-line indent) as books do to distinguish paragraphs. Indent
the second and subsequent lines of a paragraph from the left margin
(called a hanging indent) to create a properly formatted bibliography.
Indent the entire paragraph any amount from the left and right margins
(called left indents and right indents) to separate quoted passages. 

Setting Paragraph
Indents

Indent Paragraph Lines
Precisely

Click the View tab, and then select
the Ruler check box to display the
Ruler.

Click the paragraph or select
multiple paragraphs to indent:

◆ To change the left indent of the
first line, drag the First-line
Indent marker.

◆ To change the indent of the
second and subsequent lines,
drag the Hanging Indent
marker.

◆ To change the left indent for all
lines, drag the Left Indent
marker.

◆ To change the right indent for
all lines, drag the Right Indent
marker.

As you drag a marker, the
dotted guideline helps you
accurately position the indent.
You can also press and hold Alt
to see a measurement in the
ruler.

2

1
Right Indent
marker

First-line Indent
marker

Hanging Indent  marker

Left Indent
marker

Current indent settings are 
for this paragraph

First-line indent

Hanging indent

Did You Know?
You can indent using the Tab key. You
can indent the first line of a paragraph
by clicking at the beginning of the
paragraph, and then pressing Tab. You
can indent the entire paragraph by
selecting it, and then pressing Tab.
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Indent a Paragraph 

Click the paragraph, or select
multiple paragraphs to indent. 

Click the Home tab.

Click the Increase Indent button or
Decrease Indent button to move
the paragraph right or left one-half
inch.

Set Indentation Using the 
Tab Key

Click the File tab, and then click
Options.

In the left pane, click Proofing, and
then click AutoCorrect Options.  

Click the AutoFormat As You Type
tab.

Select the Set left- and first-indent
with tabs and backspaces check
box.  

Click OK.5
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Did You Know?
You can add line numbers to a docu-
ment or page. Click the Page Layout
tab, click the Line Numbers button, and
then click Continuous, Restart Each
Page, Restart Each Section, Suppress
for Current Paragraph, or Line
Numbering Options.
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The best way to draw attention to a list is to format the items with bul-
lets or numbers. You can even create multi-level lists. For different
emphasis, change any bullet or number style to one of Word’s many pre-
defined formats. For example, switch round bullets to check boxes or
Roman numerals to lowercase letters. You can also insert a picture as a
bullet or customize the numbering list style—including fixed-digits, such
as 001, 002, etc. If you move, insert, or delete items in a numbered list,
Word sequentially renumbers the list for you.

Creating Bulleted 
and Numbered Lists

Create a Bulleted List

Click where you want to create a
bulleted list.

Click the Home tab.

Click the Bullets button arrow, and
then select a bullet style.

Type the first item in your list, and
then press Enter.

Type the next item in your list, and
then press Enter.

Click the Bullets button, or press
Enter again to end the list. 

Create a Numbered List

Click where you want to create a
numbered list.

Click the Home tab.

Click the Numbering button arrow,
and then select a numbering style.

Type the first item in your list, and
then press Enter.

Type the next item in your list, and
then press Enter.

Click the Numbering button, or
press Enter again to end the list.
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Change Bullet or Number Styles

Select the list, and then click the
Home tab.

Click the Bullets or Numbering
button arrow.

Click a predefined format, or click
Define New Bullet or Define New
Number Format.

Select the appropriate options: 

◆ Bullet. Click Symbol, Picture, or
Font, and then select the
picture you want.

◆ Number. Select a numbering
style, font, and format. 

Specify the alignment and any
other formatting you want. 

Click OK.

Create a Multi-Level Bulleted 
or Numbered List

Start the list as usual.

Press Tab to indent a line to the
next level bullet or number, type
the item, and then press Enter to
insert the next bullet or number.

Press Shift+Tab to return to the
previous level bullet or number.

To format the multi-level list, select
the list, click the Multi-Level List
button on the Home tab, and then
select a format.
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Did You Know?
You can quickly create a numbered
list. Click to place the insertion point at
the beginning of a line, type 1., press
the Spacebar, type the first item, and
then press Enter. Press Enter or
Backspace to end the list.

4

6

5

Number stylesBullet styles
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To enhance the appearance of the text in a paragraph, you can quickly
add a border and shading to selected text. When you add a border, you
can specify what sides you want to include or exclude. For example,
you can add a border on just the top and the bottom and leave the
sides open. Shading colors the background behind the selected text or
paragraph. If you want to customize borders and shading by changing
line style, color, and width preferences, you can make changes in the
Borders and Shading dialog box.

Applying Borders
and Shading

Apply a Border

Select the paragraph text you
want to format.

Click the Home tab.

Click the Borders and Shading
button arrow, and then click to
select the border commands to
add or remove a border. 

Apply Paragraph Shading

Select the paragraph text you
want to format.

Click the Home tab.

Click the Shading button arrow,
and then click to select the
shading color you want to apply to
the selected text.
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Border options
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Apply Paragraph Shading and
Borders

Select the paragraph text you
want to format.

Click the Home tab.

Click the Borders and Shading
button arrow, and then click
Borders and Shading.

Click the Borders tab.

Click to select the type of Setting
you want for your border.

Click to select the type of Style.

Apply any other options you want.

Look in the preview box to see the
new border.

Click the Shading tab.

Click to select the shading fill color
you want to apply to your table.

Apply any other options you want.

Look in the preview box to see the
new shading color.

Click OK.13
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If you have confidential information in a document or text that you don’t
want others to see, you can hide the text. When you hide text, you can’t
view or print the text unless you select the Hidden Text option in the
Options dialog box. When you display or print hidden text, the charac-
ters appear with a dotted lined underneath. Hiding text does not protect
your text from being seen, but it does conceal it from others.

Hiding Text

Hide or Unhide Text

Select the text you want to hide or
the hidden text.

Click the Home tab, and then click
the Font Dialog Box Launcher.  

Click the Font tab.

Select or clear the Hidden check
box.

Click OK.

Display or Print Hidden Text

Click the File tab, and then click
Options.  

In the left pane, click Display.

Select the Hidden text check box.

Select the Print hidden text check
box.

Click OK.5
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Index

A
Access

inserting Access data in documents, 392
mail merge, importing data for, 269
merging with documents, 392-393

Accessibility Checker, 29
Accounts

adding accounts, 27
Office 365 SharePoint, 470-471
SkyDrive, 470-471

for comments, 364
work with, 27

Acrobat Reader, 404
Actions

changing options, 60-61
embedding, 425
inserting information with, 60-61
managing, 441
showing, 412
XML properties, saving as, 424

ActiveX controls, 348, 435
flash movies, playing, 465
harmful attacks and, 346-347
inserting, 460
list of, 462
properties, setting, 463
security alerts, 461
security options, 354
VBA code, adding, 464

Ad-aware, Lavasoft, 346
add-ins, 348, 435. See also COM add-ins

harmful attacks and, 346-347
loading/unloading, 372, 442-443
managing installed add-ins, 441
security alerts, dealing with, 443
setting security options, 353
user interface errors, showing, 426

viewing installed add-ins, 440
adding/removing. See also deleting

borders, 192-193
features, 434
Quick Access Toolbar, items from, 7
shading, 192-193
Status bar, items on, 9
watermarks, 190-191

Address book for mailing labels, 284
addresses

Company Address Quick Part, 244
default mailing address, 426
form letter envelopes, addressing, 284
URLs (Uniform Resource Locators), 317
Web addresses, 317

adjustment handles for shapes, 200-201
Adobe Systems

Acrobat Control for ActiveX, 462
Acrobat Reader, 404
Photoshop, 133
Type Manager fonts, 78-79

adware, 346
alerts. See security alerts
aliases in XML schemas, 386
Align commands, 212
Align Group for SmartArt graphics 

shapes, 148-149
aligning. See also objects

alignment guides, 214-215
columns, text in, 194
of equations, 262
of existing text, 76
paragraph alignment, changing, 76
tables, cells in, 164

alignment guides, 214
showing and hiding, 215
using, 215

all caps text, 68
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alternative text, 29
animation

feedback with, 426
in organization charts, 153
showing, 412

Anonymous FTP sites, 327
antivirus software, 347
Apply button, 8
App Catalog 

security options, 353
Trust Center, 348

Apps for Office
adding apps, 436
App Catalog, creating, 353
inserting apps, 438
inspecting a document with, 334-335
introduction, 435, 436
managing apps, 439
searching for apps at Office.com, 437

Arabic, support for, 298-299
arrows in dialog boxes, 8
articles, text boxes for, 198
ascending sort, 159
ASCII symbols, 264
attachments

Read Mode view
disabling attachments in, 18
opening in, 408

harmful attacks and, 346-347
options, for opening, 408

authors, multiple
co-authoring, 494-495
blocking authors, 496

Author Quick Part, 244
AutoComplete, 50, 418
AutoCorrect, 62-63

example of changes, 63
spell-checking with, 288-289

AutoCorrect Exceptions dialog box, 62
AutoFit for tables, 165
AutoFormat

for long documents, 226-227
revising documents with, 226

Automated Safe mode, 358-359
automatic links, updating, 426
Automatic Updates, 347
AutoRecover, 33

Default File Locations, 422-423
AutoShape, 431
AutoText

printing, 312
working with, 246-247

averaging values in table cells, 172
Avery Standard 1649 labels, 280-281

B
Back button, 5
background

printing in, 417
repagination, enabling, 426
Web pages, opening, 314

backgrounds
page backgrounds, adding, 192-193
print options, 416
removing picture, 136
as shape fills, 206
WordArt fill and, 138

Backspace key, 52
bulleted or numbered list, ending, 63

Backstage view, 3, 5
balloons. See sharing documents
Banded Row or Banded Column option, 170
bevel effect, 211
bibliographies

citation and source, adding, 254
indents, setting, 82
placeholders, adding, 255

Bing
Dictionary, using, 301
Image Search, 116-117, 208
in Read Mode view, 18-19
Video Search, 154

bitmap images. See BMP files
black and white color option, 132
blank documents, creating, 36
block authors, 496
Blog Accounts dialog box, 332
Blogger, 328-332
blogs

creating postings, 328-329
document contents, creating blog, 

328-329
existing posting, opening, 330
managing accounts, 332
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viewing on the web, 331
BMP files

cropping bitmapped pictures, 134-135
modifying pictures, 133
resizing images, 129

boilerplate for mail merge, 268
boldfacing

in index, 238
long documents, formatting in, 226
shape text, 205
text, 66, 68

bookmarks
creating, 256
for indexes, 238-239
navigating to, 256-257
showing, 412

borders. See also paragraphs
painter, 169
tables, 168-169

adding/removing, 192-193
applying, shading and borders, 86-87
edge, moving, 10
pictures, adding to, 126
tables, styles, applying to, 166

Borders and Shading dialog box, 86-87
bottom-aligning objects, 212-213
bound document, preparing for, 233
breaks. See also page breaks

column breaks, inserting, 194-195
brightness of pictures, 

changing, 131
Bring Forward for objects, 216
Bring to Front

for objects, 216
SmartArt graphics shapes, 148-149

broadcasting online
with Office Web App, 398-399

browsers
documents, opening, 12, 315
viewing Web pages from, 317

browsing in documents, 48
Building Block gallery form controls, 458
Building Blocks Organizer, 245
bulleted lists

copying/pasting options, 419
creating, 63, 84
multi-level lists, creating, 85
options, 418

style of bullets, changing, 84-85
buttons. See also specific types

in dialog boxes, 8

C
Cancel button, 8
capitalization

AutoCorrect changes, 63
drop caps, 188-189
Match Case option, 72
uppercase text, 68

Caps Lock button, 9
captions, creating, 258
case of text

changing, 68
Match Case option, 72

cells. See tables
center-alignment

of equations, 262
objects, 212-213
of text, 76

centered as group alignment of 
equations, 262

certification authority (CA), 342
Change Color button, 153
Character Code box, 264
characters. See also symbols

drop caps, 188-189
finding and replacing special 

characters, 73
inserting special characters, 265
spacing, changing, 78-79, 420
styles, 92
wildcards, finding and replacing with, 75

charts. See also organization charts
axis titles, changing, 179, 181
bar charts, formatting, 182
callouts, data labels, 181
creating, 173
custom chart templates 

creating, 185
managing, 186

data labels, changing, 179, 181
deleting, 176
drop lines in, 182
editing data in, 174-175, 183
elements, adding, 179
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entering data in worksheets, 175
entire chart, changing type for, 176
error bars in, 182
filtering data, 184
formatting elements, 178
gridlines, showing/hiding, 179, 181
high-low lines in, 182
inserting, 173
layout, changing, 177
legends, changing, 179, 181
line charts, formatting, 182
managing chart templates, 186
opening chart data, 174
saving chart templates, 185
series lines in, 182
showing/hiding elements, 180
style, changing, 177
titles, changing, 179, 180
trendlines, options for, 182
type, changing, 176
up/down bars in, 182
viewing chart data, 174
wrapping text around, 196-197

Check Box button, 462
check boxes, 8

Check Office documents that are from or
link to suspicious Web sites check
box, 347, 357

Check Office documents that are from or
link to suspicious Web sites check
box, 347, 357

Chinese, support for, 298-299
circles, drawing, 200
citations, adding, 254-255
class modules in VBA, 445
Classic style set, 98
Click-And-Type text, 76
clip art, 115.  See also online pictures

cropping, 134-135
locating and inserting, 116
recoloring, 132-133
shapes, applying picture fills to, 208

Clipboard
copying text to, 54-55
options, changing, 54
storing text on, 52

Close button, 44

closing
documents, 34
task window, 10
window panes, 10

code. See VBA (Visual Basic for
Applications)

colors. See also font colors; gradient fills;
themes

menus, adding to, 101
for organization charts, 153
page colors, adding, 192-193
properties of, 105
recoloring pictures, 132-133
shapes, adding color fills to, 208-207
SmartArt graphic colors, changing, 147
themes, selecting, 104
3-D colors to shapes, adding, 211
Web page colors, changing, 315

columns and rows. See also charts; tables
breaks, inserting, 194-195
mail merge data, displaying, 273
modifying text columns, 194-195
newspaper-style columns, 194-195

COM add-ins, 441. See also ActiveX 
controls

loading/unloading, 442-443
Combo Box button, 462
combo box form controls, 458
command buttons, 4, 462
commands

accessing commands not on Ribbon, 430
choosing, 5

comments
all comments, deleting, 366-367
editing, 366
handwritten comments, inserting, 365
inserting, 364
marking as done, 365
reading comments, 366
replying to, 365
specific reviewer, deleting comments

from, 366-367
voice comments, inserting, 364

Company Address Quick Part, 244
Company E-mail Quick Part, 244
Company Quick Part, 244
comparing documents, 370-371
Compatibility Checker, 28
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compatibility mode
converting existing documents, 15
diagnostics, 434
options, setting, 427
saving documents, 22

compressed zip package, 459
compressing pictures, 130
connection status help, 21
content controls, 458-459
content filtering, 357
contextual spelling, 292-293
contextual tabs, 4
contrast in pictures, changing, 131
converting existing documents, 15
copy, opening document as, 12
copying. See also drag-and-drop; text

Excel, data from, 388-389
hyperlinks, 322
importing/exporting with, 382-383
macros, 453
options, changing, 419
templates, functionality between,372-373
window contents, 121

copyright symbols, 78-79
cover pages for long documents, 241
cropping

pictures, 134-135
showing crop marks, 412

cross references
in documents, 232
in index, 238

CSS (Cascading Style Sheets), 326
custom dictionaries, 290-291
Custom Dictionaries dialog box, 290-291
Customize Quick Access Toolbar list arrow, 6
customizing, 407. See also Word Options

advanced document properties, 30
caption labels, 258
drop caps, 188-189
hyphens, 59
Installed Templates, 114
line numbering options, 261
margins, 302-303
picture fills for shapes, 208
Quick Access Toolbar, 7
texture fills for shapes, 208
theme colors, 104-105

watermarks, 190-191
cutting options, 419
cycle graphic type, 142

D
damaged files, opening, 12
data documents, 267

creating, 271
editing, 272
identifying, 269

data labels, changing, 181
data series, 173
Spreadsheet Compare, 432
databases. See Excel
Date Picker, 458
dates and times

in headers or footers, 228
inserting in documents, 230-231

Debug toolbar, 452
debugging macros, 448, 452
decimals, displaying table numbers as, 172
Default File Locations, 422-423
Default Programs, extensions

options, 408
definition of words, getting, 301
Delete key, 52
deleting. See also tables; themes

AutoText entry, 247
borders from pictures, 126
charts, 176
chart templates, 186
column breaks, 195
columns, 194
comments, 366-367
dialog boxes, files in, 12
digital signatures, 343
encrypted files, 337
footnotes and endnotes, 251
guides, 215
hard page breaks, 306
headers or footers, 228
hyperlinks, 322-323
hyphens, 59
with keyboard, 52
macros, 451
page numbers, 230
password protection, 339
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Quick Access Toolbar, items from, 7
section breaks, 306-307
shapes, 200
SmartArt graphic shapes, 145
Status bar, items on, 9
styles, 90-91
tables of contents, 237
text, 52-53
theme colors, 105
watermarks, 190-191
XML tags, 386

descending sort, 159
Design Mode. See ActiveX controls
desktop publishing

backgrounds, 192-193
colors, adding, 192-193
columns, working with, 194-195
drop caps, adding, 188-189
text boxes, working with, 198-199
watermarks, 190-191
wrapping text around object, 196-197

destination files, 380, 384
Developer tab

ActiveX controls on, 460
options, setting, 447
showing, 447

diagnosing/repairing problems, 434
Dialog Box Launchers, 3, 8
dialog boxes

deleting files in, 12
options, choosing, 8
renaming files in, 12

dictionaries
custom dictionaries, 290-291
exclusion dictionaries, 290-291
familiar words, adding, 289
for spell-checking, 288

Dictionary app for Office
adding app, 436
getting definitions, 301
inserting app, 438

digital signatures, 342-343
macro projects, adding to, 454
Status bar, checking with, 9
XPS support for, 405

direction
shapes, 3-D effects on, 211
tables, changing text direction in, 164
text box, changing text direction in, 198
WordArt text, changing direction of, 141

disk diagnostics, 434
Distinctive style set, 98
distributing objects, 212
DOCM files, 25
Document Information Panel, 30

for final documents, 360
selecting template, 466

Document Inspector, 334-335
Document Library, 472
Document Properties for Quick 

Parts, 244-245
Document Style Sets

applying, 98
creating, 99
reset a style, 99
setting default style, 99

documents, 1, 256. See also comments; for-
matting; grammar-checking; long doc-
uments; macros; mail merge; metada-
ta; printing; read-only documents;
saving; sharing documents; spell-
checking; technical documents; text;
themes

Access database in, 392-393
AutoText, working with, 246-247
bibliographies, 254
blank document, creating, 36
bound document, preparing for, 233
browsing through, 48
captions, creating, 258
closing, 34
Compatibility Checker, 28
converting existing documents, 15
cover pages for, 241
cross references, inserting, 232
Default File Locations, 422-423
digital signatures, 342-343
Document Inspector, 334-335
double-sided documents, printing, 310
Excel worksheets, inserting, 388-389
existing document, opening, 12-13
final documents, 360
headers and footers in, 228-229
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hyphens, inserting, 58-59
inconsistent formatting, checking 

for, 286-287
inspecting documents, 334-335
letters, creating, 39
lines, numbering, 83, 260-261
memos, creating, 39
merging documents, 370-371
multiple-author documents, 

creating, 224-225
multiple documents, working with, 46-47
new documents

blank documents, creating, 36
existing document, creating from, 38
templates, creating from, 37

Office Web App, creating, 467
page numbers, inserting, 230-231
paging through, 48
part of document, allowing changes, 341
passwords for, 338-339
PowerPoint slides, creating, 390-391
previewing, 308
proofing, 288-289
properties, viewing, 30
Quick Parts, inserting, 244
in Read Mode view, 18-19
readability of documents, 289
reading, 18-19
Recent Documents, accessing, 414-415
recovering documents, 32-33
restricting formatting/editing, 340-341
selecting text in, 50-51
single file Web page, saving document

as, 324-325
subdocuments, inserting, 224-225
symbols, inserting, 264-265
tables in slide, embedding, 390-391
tables of contents for, 236-237
tables of figures, 259
templates, creating with, 37
in Thumbnail pane, 18-19
two-sided documents, printing, 310
views, changing, 16-17
Web page, opening as, 314-315
word count statistics, 240
zooming view, 31

DOCX files. See documents
double-sided documents, printing, 310

double strikethrough text, 68
double-tap, 429
Download.com, 347
downloading. See also security

Acrobat Reader, 404
add-ins, 440
checking files on, 347
FTP (File Transfer Protocol) files, 327
Office program Viewer, 12
templates, 37
XPS file viewers, 405

draft quality printing, 417
Draft view, 16-17
drag-and-drop

options, 418
SmartArt graphics, 142-143
for text, 52-53

drawings
print options, 416
showing on screen, 412

drop caps, 188-189
drop down list form controls, 458
drop lines in charts, 182
duplex printing, 310, 417
duplicate words, eliminating, 288

E
e-mail. See also attachments

Company E-mail Quick Part, 244
document for review, sending, 374-375
FTP (File Transfer Protocol) and, 327
hyperlinks for sending, 319
mail merge to, 278-279
PDF files, sending, 374-375
spam, 346
XPS files, sending, 374-375

Edit Data Source dialog box, 183
Edit Points command, 203
editing. 

AutoCorrect entries, 63
changing options, 286, 418
chart data, 174-175, 183
comments in shared documents, 366
data documents, 272
embedded objects, 384
exclusion dictionaries, 289-290
final documents, 360
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footnotes and endnotes, 251
freeforms, 203
hyperlinks, 322
macros, 453
mail merge fields, 275
in Print Preview, 308
PDF documents, 40-41
properties of document, 30
restricting formatting/editing, 340-341
text, 52-53
theme colors, 105
WordArt text, 137
XML data files, 386

eFax, 376
effects. See also shadow effects; 3-D effects

pictures, adding to, 127
theme effects, choosing, 108
WordArt, applying to, 140

Elegant style set, 98
em/en dashes, 63, 226
embedding, 380. See also charts

Excel, data from, 388-389
existing objects, 385
fonts on saving documents, 424-425
linguistic data, 425
new objects, 384-385
save options, 424-425
slides, Word tables in, 390-391
video from the web, 154

emboss text, 68
en/em-dashes, 63, 226
encryption of files, 336-337
endnotes. See footnotes and endnotes
engrave text, 68
Enhanced ScreenTips, 296
envelopes. See form letters
Equations gallery, 262
equations in technical documents, 262-263
error bars in, 182
Esc key for format painting, 100
European languages, support for, 298-299
Excel. See also charts

document, inserting worksheets 
in, 388-389

importing
data, 388-389
worksheets, 382

mail merge, importing data for, 269
opening, 14
picture, importing data as, 389

exclusion dictionaries, 290-291
existing document, opening, 12-13
exiting

Word, 34
exporting. See importing/exporting
expressions, VBA, 444

F
Facebook

adding account to Office, 27
sharing with, 478-479, 486-487, 

494-495
Fancy style set, 98
faxing

Internet fax, sending document by, 376
Features, adding or removing

Office, 434
feedback options, setting, 426
fields. See also mail merge

caption fields, adding, 258
codes, inserting and using, 366
displaying and updating, 366
navigating in document with, 234-235
Quick Part building blocks, 244-245

figures
cross references to, 232
tables of figures, 259

file block settings, 348, 350-351
file extensions, displaying, 15
file formats

list of, 25
saving documents in, 24-25

File tab, 3, 5
files. See also documents

default locations, changing, 422-423
encryption, 336-337
non-Word format files, opening, 14
pictures from file, inserting, 121
WordArt text, applying to, 138-139

FileZ, 347
Fill Color button, 101
fills. See also shapes

gradient, 209
shapes, adding color fills to, 208-207
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tables, applying to, 168
filtering

chart data, 184
content filtering, 357
mail merge, records for, 273

FIM-A codes, 284
Find and Replace dialog box

Match Case option, 72
specific page in long document, 234

Find command, 56-57
finding and replacing. See also formatting

items, finding, 72
locations, finding, 72
text, 56-57

Firewall. See Windows Firewall
first-line indents, 82
flash movies, playing, 465
Flesch-Kincaid Grade Level score, 289
Flesch Reading Ease score, 289
Flickr

adding account to Office, 27
inserting picture from, 118-119, 208
sharing with, 478-479, 486-487, 

494-495
flipping

objects, 217
floating tables, 156
Font Color button, 101

last font color, displaying, 107
font colors

last font color, displaying, 107
shape text, adding to, 205
text, 66

Font dialog box, 78-79
for shape text, 205

fonts. See also font colors
changing fonts, 66
changing options, 420
CSS (Cascading Style Sheets) for Web

pages, 326
deleting theme fonts, 108
draft fonts, using, 412
for drop caps, 188-189
embedding fonts on saving, 424-425
for indexes, 239
for letters or memos, 39
point size, 67
printer fonts, 67

shapes, text in, 205
smoothing, option, 413
stored on printer, option, 412
symbols, availability of, 264
theme fonts, choosing, 106-107
TrueType fonts, 67
Web page font, changing, 315

footers. See headers and footers
footnotes and endnotes

continuation notice, adding, 253
converting notes to, 253
creating, 250
editing, 251
formatting, 252-253
navigating in document by, 234-235
renumbering, 252

foreign languages, 274
adding languages to program, 298-299
keyboard, enabling, 295, 298-299
proofing, 294-295
support for, 274
thesaurus for, 293
translating text to, 296-297

form controls, 458-459, 460
form letters, 267

common words, use of, 275
creating, 274-275
envelopes

addressing, 284
creating, 282-283

extra spaces, 275
mailing labels, 284
personalizing, 277
printing, 277

Formal style set, 98
Format Cells, 66-67
Format Painter, 100
Format Shape pane, 206, 209
formatting. See also aligning; charts; fonts;

SmartArt graphics; styles; tables
applying, 69
automatic formatting for long 

documents, 226-227
bar charts, 182
case of text, changing, 68
chart elements, 178-179
clearing, 69, 70
comparing text formatting, 97
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effects, 68-69
for emphasis, 68-69
finding and replacing, 72-73

special formatting, 74-75
footnotes and endnotes, 252-253
graphic formats, adding, 121
inconsistent formatting, checking 

for, 286-287
in index, 238
line charts, 182
line numbers, adding, 83
line spacing, changing, 77
long documents, automatic formatting

for, 226-227
marks, viewing, 81
options, 71
quickly formatting text, 66-67
restricting formatting/editing, 340-341
shapes, text in, 205
similar formatting, selecting text with, 70
SmartArt shapes, 206
WordArt text, 138-139

forms.
controls, adding, 458
field properties, changing, 459
security for, 459

Formula dialog box, 172
FoxPro, 269
frames, hyperlinks between, 320-321
freeforms

converting shapes to, 203
defined, 187
drawing, 203
modifying, 203

French, translating text to, 296
FTP (File Transfer Protocol), 327
function procedures, VBA, 445

G
galleries, 3
gestures, 429
GIF files, 133
glow

in organization charts, 153
pictures, adding to, 127
shapes, adding to, 211

in text, 68-69
Go To dialog box

bookmarks, selecting, 256
navigating in document with, 234-235

gradient fills, 209
grammar-checking

settings, changing, 293
showing/hiding errors, 292

grammar-checking documents, 288-289
graphical lists, 142
graphics. See also clip art; pictures; shapes;

SmartArt graphics; WordArt
AutoText, working with, 246-247
navigating in document by, 234-235
SmartArt, graphic layouts, 142, 151
wrapping text around, 196-197

grayscale color option, 132
Grid and Guides dialog box, 214-215
gridlines

chart gridlines, showing/hiding, 181
objects, aligning, 214-215
showing/hiding, 215
table gridlines, showing/hiding, 160

grouping/ungrouping
objects, 218-219
tables, 218
tabs, controls on, 4

guides
alignment guides, 214-215
deleting, 215
objects, aligning, 214-215
showing/hiding, 215

gutters, setting up, 233, 302-303

H
hackers, 336
handwritten comments, inserting, 365
hanging indents, 82
hard page breaks, inserting/deleting, 306
hardware graphics acceleration, 413
headers and footers

for different pages, 229
in long documents, 228-229
Quick Parts for, 244

headings
collapsing, 306-307
cross references to, 232
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expanding, 306-307
navigating in document by, 234-235
options, 412
in outlines, 222
text boxes for, 198

Hebrew, support for, 298-299
height

of drop caps, 188-189
of rows, 162-163

help
connection status help, 21
Help Viewer, 20-21

Help Viewer, 20-21
Web page appearance, changing, 315

hidden text. See text
hiding. See showing/hiding
hierarchy graphic type, 142. See also

organization charts
high-low lines in charts, 182
highlighting

text, 68
homographs, 346
horizontal ruler, 80
HSL colors, 101, 104-105
HTM/HTML files, 25
HTML (Hypertext Markup Language), 313.

See also Web pages
pixels for HTML features, showing, 413
hue, 105
hyperlinks, 381

between documents, inserting, 319
deleting, 322-323
within document, inserting, 318
e-mail, sending, 319
editing, 322
frames, creating between, 320-321
options, 418
ScreenTips for, 323
in table of contents, 236
theme colors, 102
using, 322

hyphens, 58-59
long documents, formatting in, 226
setting hyphenation options, 80
words, hyphenating, 289

I
Image button, 462
Images

Default File Locations, 422-423
importing/exporting, 380. See also Excel;

mail merge
with copy and paste, 382-383
files, importing, 383
other programs, exporting to, 383
inconsistent formatting, checking 

for, 286-287
indents

paragraph indents, setting, 82-83
with Tab key, 82-83

indexes, 238-239
multiple page entries, 239

Insert Hyperlink dialog box, 320-321
inspecting documents, 334-335
Installed Templates, 114
instant messaging. See also Lync;

SharePoint
with Lync, 377

InterFAX, 376
international languages. See foreign 

languages
Internet. See also blogs; browsers; hyper-

links; Microsoft Office.com Online;
Office Web Apps, SkyDrive,
SharePoint, web pages

fax, sending document by, 376
FTP (File Transfer Protocol), 327
parental controls, setting, 357

Internet Properties dialog box, 315
italicizing

in index, 238
long documents, formatting in, 226
shape text, 205
text, 66, 68

J
Japanese, support for, 298-299
JPG files, 133
justification

of equations, 262
of text, 76
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K
kerning, 78-79
keyboard

correcting typing with, 52
foreign languages, accommodating, 298-

299
grid settings, overriding, 215

keyboard language, 295
KeyTips, 4
Korean, support for, 298-299

L
Label button, 462
labels

captions, custom labels for, 258
mail merge, creating with, 280-281
mailing labels, 284

landscape orientation. See orientation
languages. See foreign languages
Lavasoft Ad-aware, 346
Layout Styles groups, 153
layouts. See also page setup

for charts, 177
for organization charts, 153
SmartArt graphic layout, changing, 

142, 147
leaders

in table of contents, 236
in tables of figures, 259

left-alignment
of equations, 262
of objects, 212-213
of text, 76

left indents, 82
Legacy tools, 458
legends in charts, 181
letters. See also form letters; mail merge

creating, 39
ligatures, 78-79
lighting 3-D effects with shapes, 211
Linear equation display, 262
lines

defined, 187
document lines, numbering, 83, 260-261
numbers, adding, 83, 260-261
spacing, changing, 77

linguistic data, embedding, 425

Linkedin
adding account to Office, 27
sharing with, 478-479, 486-487, 

494-495
Linked Notes, from OneNote

creating, in Word, 395
opening, in Word, 395

links/linking, 380. See also hyperlinks
charts to worksheet cells, 180
existing objects, 385
files in Word, 382
with Paste Special, 384
printing, updating linked data 

before, 416
text boxes, linking, 198-199
updating links, 385

List Box button, 462
list boxes, 8
lists, 3

graphical lists, 142
table lists, sorting, 159

live layout preview
resize or adjusting objects, 150, 200-201
moving objects, 200
options, 410

live preview, 4
enabling, 410
Paste Options, 54
theme fonts, 106

loading/unloading
add-ins, 372, 442-443
templates, 372

locking/unlocking master documents, 225
logos

on letters or memos, 39
as watermarks, 190-191

long documents, 221, 256. See also techni-
cal documents

AutoFormat for, 226-227
automatic formatting for, 226-227
AutoText, working with, 246-247
bibliographies, 254
bound document, preparing for, 233
browse object, navigating with, 234-235
captions, creating, 258
cover page, adding, 241
cross references, inserting, 232
gutters, setting, 233
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headers and footers in, 228-229
indexes, creating, 238-239
lines, numbering, 260-261
multiple-author documents, 

creating, 224-225
navigating

with browse object, 234-235
to specific page, 234

numbering lines in, 260-261
outlines, creating, 222-223
page numbers, inserting, 230-231
searching in, 234
specific page, moving to, 234
subdocuments, inserting, 224-225
symbols, inserting, 264-265
tables of contents for, 236-237
tables of figures, 259
word count statistics, 240

Lotus 1-2-3 files, 14
lowercase text, 68
luminosity, 105
Lync, communicating online. See also

SharePoint
contacts, adding, 403
instant messaging with, 377
introduction, 402
meeting presentation, 400-401
notes, adding from OneNote, 402
starting, 402
recordings, managing, 401, 403
using, 402-403

M
Macro Recording and Playback, 9
macros, 348, 435

copying to other documents, 453
creating, 450
debugging, 448, 452
deleting, 451
description of, 448
digital signatures, adding, 454
editing, 453
harmful attacks and, 346-347
opening documents with, 457
Personal Macro document, 448
Quick Access Toolbar, adding to, 455
recording, 449

running, 451
saving documents with, 456
security alerts with, 457
self-signing certificates, creating, 454
setting security options, 355
stopping, 451

mail merge, 267. See also data documents;
form letters

with Access database records, 392-393
common words, use of, 275
database, importing data from, 269
to e-mail, 278-279
excluding recipients from, 276
extra spaces, 275
filtering records, 273
labels, creating, 280-281
Outlook, importing data from, 270
personalizing, 277
previewing, 276
printing, 277
sorting records, 273
starting Mail Merge wizard, 268

Mail Merge wizard, 267. See also data 
documents

Outlook, importing data from, 270
starting, 268

Mailing tab, 267
maintenance, performing, 434
Manage Source dialog box, 254-255
Manage Styles dialog box, 94-95
Manager Quick Part, 244
Manual Duplex option, 310
margins

options, changing, 420-421
Page Setup, creating with, 302-303
quickly selecting standard margins, 303
tables, changing cell margins in, 164-165
visually adjusting, 302

Mark as Final command, 360
markup

comments, working with, 364-367
printing, 312
using, simple markup, 368-369

master documents, creating, 224-225
mathematical symbols, 262
matrix graphic type, 142
Maximize button, 44
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maximizing/minimizing
Ribbon, 4, 6
windows, 44

McAfee antivirus software, 347
measurement units, 413
Memo wizard, 39
memory diagnostics, 434
memos, creating, 39
menus. See also shortcut menus

colors, adding, 101
File tab, 5

merge fields, 267
merging. See also mail merge

Access database records, 392-393
cells in tables, 162
documents, 370-371

Message Bar, 348
changing security options, 356
macros in, 355, 454

messages. See also e-mail
metadata, 334

customizing, 428
viewing, 30

methods, VBA, 444
MHT/MHTML files, 25
Microsoft. See also Excel; Outlook;

PowerPoint
Customer Experience Improvement

(CEIP) program, 348
Forms 2.0 controls, 462
InfoPath controls, 462, 466
Paint, 133
Web Browser, 462
Works, opening, 14

Microsoft Excel. See Excel
Microsoft Lync. See Lync
Microsoft Office Online, Office.com

Help Viewer, 20-21
templates, choosing, 37
themes, searching for, 103

Microsoft Organization Chart. See organiza-
tion charts

Microsoft Outlook. See also e-mail
Internet Fax, sending document by, 376

Microsoft PowerPoint. See PowerPoint
Microsoft SharePoint. See SharePoint
Microsoft SkyDrive. See SkyDrive
Microsoft Windows Metafile, 116

middle-aligning objects, 212-213
Mini-Toolbar

commands on, 5
formatting actions, 66
options, 410
showing, 410

Mini Translator, 296-297
Minimize button, 44
minimizing. See maximizing/minimizing
mobile devices 

using, 469, 490-491
Modern style set, 98
modules in VBA, 445
mouse, resizing windows with, 44
movies, playing, 465
moving. See also navigating

Clipboard, text in, 54
hyperlinks, 322
live layout preview, 200

options, 410
Quick Access Toolbar, 6
in tables, 158
windows, 44

multiple-author documents, 
creating, 224-225

multiple documents, working with, 46-47
My Data Sources folder, 269
My Templates, 111-112, 185-186. See also

templates
default folder location for templates,

422-423
MyFax, 376

N
names. See also renaming

dialog boxes, files in, 12
in headers or footers, 228

navigating. See also long documents
to bookmarks, 256-257

Navigation pane
browsing, 48
displaying, 18-19
finding and replacing, 56
headings and page view, 19
searching, 48-49

nested tables, 156, 165
new document, creating, 36
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New Document, templates, 114
New screen, 36

opening templates, 113
opening new documents, 36-39
templates, choosing, 37

newspaper-style columns, 194-195
nonbreaking hyphens, 58-59
Normal global template, 372
Normal view, 261
notebook (OneNote)

creating, 395-396
Office Web App, creating, 469, 485, 490
opening, 396-397
opening from Word, 395

notes. See also footnotes and endnotes
converting, 253

Notes pane. See footnotes and endnotes
Num Lock, 9
numbered lists

copying/pasting options, 419
creating, 63, 84
multi-level lists, creating, 85
options, 418
style of numbers, changing, 84-85

numbering. See also page numbers
customizing line numbering options, 261
document lines, 260-261

O
objects. See also embedding; shapes; VBA

(Visual Basic for Applications)
aligning, 212-213

to grids and guides, 214-215
clip art objects, 116
connecting two shapes, 216
customizing creation methods, 431
distributing objects, 212
flipping, 217
grouping/ungrouping, 218-219
hard-to-select objects, selecting, 212
hidden objects, viewing, 216
preset increments, rotating/flipping 

with, 217
rotating, 217
selecting

order, objects in, 218
with Selection pane, 220

Selection pane, selecting with, 220
stacking order, changing, 216
troubleshooting arrangement of, 219
VBA objects, 444
wrapping text around, 196-197

Office 365. See also SharePoint 
App Catalog, creating, 352
connecting to, 468-469
introduction, 468-469

Office.com
applying picture or texture fills from, 208
Apps for Office, 436-439
clip art, inserting, 116
definition of words, dictionary apps, 300-

301
Help Viewer, 20-21
inserting pictures from, 116-117
options, 426
SmartArt graphics, 142
text boxes, 198
templates, choosing, 37
themes, searching for, 103

Office Clipboard. See Clipboard
Office Mobile. See mobile devices
Office options

Background and themes, 409
Office Presentation Service

broadcasting online, 398-399
Office Store. See Office.com
Office tools. See Database Compare;

Foreign languages, SkyDrive Pro;
Spreadsheet Compare; Telemetry Log;
Telemetry Dashboard; Upload Center

Default File Locations, 422-423
Office Web Apps

accessing documents, 474-475, 480-481
collaborating, documents with, 469, 494-

495
blocking authors, 496

compare to desktop app, 488-489
creating documents, 485
downloading files for, 484, 492
editing documents, 491
introduction, 467-469
linking to documents, 486-487
mobile devices, 469, 490-491
opening documents, 490
preparing to use, 468-469
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printing documents, 492

creating PDF, 492
roundtripping, 495
saving documents, 492
signing in to access, 468-469, 470-471
syncing documents, 476-477
uploading files for, 484, 492
viewing documents, 490-491

OLE (object linking and embedding), 380.
See also ActiveX controls

online meeting
with Lync, 400-401

online presentation
with Office Web Apps, 398-399

Online Services
adding account to Office, 27
inserting picture from, 118-119
inserting video from, 154
saving to, 26
sharing with, 478-479, 486-487, 

494-495
OneNote

creating, 396-397
creating, in Word, 395
opening, in Word, 395
send to, 396-397
sharing

with Lync, 402-403
with Office Presentation Service,

Office Web Apps, 398-399
work with, 396-397

Open screen
default file location, changing, 13
file extensions, displaying, 15
properties, changing, 30

OpenDocument Text (ODT), 25
Open Packaging Convention, 459
opening

blog postings, 330
encrypted files, 337
existing documents, 12-13
macros, documents with, 457
non-Word format files, 14
password-protected documents, 339
PDF documents, 40-41
templates, 113
Web page, document as, 314-315

XML data files, 386-387
OpenType

character spacing, 78-79
option buttons, 462

in dialog boxes, 8
optional hyphens, 58-59
options, for Word, changing. See Word

Options
organization charts

colors, changing, 153
creating, 152
dotted lines in, 153
layout, changing, 153
lines in, 153
Quick Styles for, 153

orientation
quick setup options, 42
SmartArt graphic orientation, 146

Original document status, 32
orphans, 305
Outline view, 16-17, 222-223
outlines

display, changing, 223
for long documents, 222-223
for master documents, 224-225
PowerPoint presentation, creating out-

line from, 394
shapes, applying color outline to, 207
text, 68
as you type, creating, 261

Outlining Tools group, 222-223
Outlook

mail merge, importing data for, 270
opening, 14

P
page breaks

controlling, 305
hard page breaks, inserting/deleting, 306

page covers, 244
page numbers

background repagination, enabling, 426
in headers or footers, 228
inserting in documents, 230
Status bar, checking with, 9

page setup. See also orientation
customize size options, 43
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display options, setting, 411
margins, adjusting, 302-303
options, changing, 420-421
quick setup options, 42
section breaks, inserting and 

deleting, 306-307
paging in documents, 48, 234-235
Paint Shop Pro, 133
painting, format, 100
paper size, 304

options, changing, 420-421
paragraphs. See also desktop publishing

alignment, changing, 76
borders

adding/removing, 192-193
applying, 86-87

cross references to, 232
default paragraph text, changing, 421
drop caps, 188-189
indents, setting, 82-83
marks, showing/hiding, 81
page breaks, controlling, 305
selecting, 50-51
shading

adding/removing, 192-193
applying, 86-87

smart paragraph selection, 418
styles, 92
table of contents, adding to, 236
tabs, setting, 81

parental controls, setting, 357
passwords

deleting password protection, 339
for documents, 338-339
with file encryption, 336-337
for FTP (File Transfer Protocol), 327
part of document, allowing changes, 341
strong passwords, using, 336
templates, protecting, 373

Paste Link in PowerPoint presentation, 394
Paste Options button, 54

live preview, 54
Paste Special

Excel worksheets, inserting, 388-389
linking with, 384

Paste Special button, 54-55
pasting

importing/exporting with, 382-383

options, changing, 419
with special results, 54-55
text, 54-55

PDF files, 25
document as PDF file, sending, 374-375
editing, 41
saving document as, 404
Office Web Apps, 492
opening, 40

permissions
Status bar, checking with, 9

Personal Macro document, 448
Personal Templates. See templates
personalizing form letters, 277
phishing, 346
Picture Border button, 126
Picture Effects gallery, 127
Picture Quick Style Gallery, 124
Picture Shape gallery, 125
pictures. See also shapes

artistic style, 123
Bing Image Search, 116-117, 208
borders, adding, 126
brightness, changing, 131
compressing, 130
contrast, changing, 131
cropping pictures, 134-135
effects, adding, 127
Excel data as picture, importing, 389
file, inserting from, 121
form controls, 458
online services, inserting from, 118-119
placeholders, showing, 412
precisely resizing/scaling, 128-129
Quick Styles, adding, 124
recoloring, 132-133
removing background, 136
resetting to original state, 133
resizing, 128-129
rotating pictures, 134-135
scaling pictures, 128-129
Screen shot 

capturing, 122
inserting, 122

shapes 
applying pictures, 125
applying picture fills to, 208
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SharePoint, inserting from 120
SkyDrive, inserting from, 120
sharpen and soften, 131
SmartArt, graphic layouts, changing,

142, 151
transparent backgrounds, setting, 132-

133
wrapping text around, 196-197

pinning with Recent Documents or Folders
list, 12-13, 414-415

pixels for HTML features, showing, 413
PNG files

modifying pictures, 133
Web page option, 326

points for fonts, 67
polygons. See freeforms
Pop-up Blocker, 346
portrait orientation. See orientation
POSTNET bar code, 284
PowerPoint. See also gridlines; guides

documents, creating slides, 390-391
outline from presentation, creating, 394
themes, matching, 103

presenting online
with Office Web App, 398-399

presentation (PowerPoint)
Office Web App, creating, 469, 485, 490

presets
gradient fills with presets, applying, 209
rotating/flipping objects with, 217

preview boxes, 8
previewing. See also live preview

documents, 308
mail merge, 276
styles, 95
Web pages, 316-317

previous versions, showing, 12
Print command, 1
Print screen

Manual Duplex option, 310
previewing work in, 308

Print Layout view, 16-17, 411
background colors/images, showing, 412
ruler, displaying, 413

Print Preview, 308
Web pages in, 316-317

printer fonts, 67

printing
all of document, 309
AutoText entries, 312
displaying print options, 416
document properties, 312
double-sided documents, 310
draft quality printing, 417
duplex printing, 310, 417
form letters, 277
gutters, setting, 233
hidden text, 88, 416
key assignment, shortcuts, 312
mail merge, 277
mailing labels, 284
markup, list of, 312
Office Web Apps, 492
options, changing, 417
pages per sheet, 311
part of document, 309
in reverse order, 417
speed, improving, 304
styles, 312
track changes, documents with, 368-369
two-sided documents, printing, 310

privacy, 348
link to Trust Center, 348
parental controls, setting, 357
setting options, 357

Privacy dialog box, 2
procedures, VBA, 445
process graphic type, 142
Product key

Office, 434
Professional equation display, 262
program tabs, 4
projects, VBA, 445
proofing documents, 288-289. See also

grammar-checking; spell-checking
languages, 294-295
options, changing, 292-293
thesaurus, working with, 293

properties
for ActiveX controls, 463
advanced document properties, 30
of colors, 105
document properties, viewing/editing, 30
editing document properties, 30
form field properties, changing, 459
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Save As screen, changing with, 30
table properties, changing, 163
VBA properties, 444
XML properties, saving as, 424

protected view, 348, 350-351
public key, 342
publishing. See blogs; desktop publishing;

Web pages
pull quotes, 198

Quick Parts for, 244
pyramid graphic type, 142

Q
Quick Access Toolbar, 1, 3

add-ins, loading/unloading, 442
adding/removing items from, 7
commands not on Ribbon, 430
commands on, 5, 6
customizing, 7
macros, adding, 455
moving, 6
Quick Print button, 309
resetting, 6, 430
voice comments, inserting, 364

Quick Parts, 244-245, 458
Quick Print button, 309
Quick Styles

artistic style, picture, 123
adding styles to, 94
for organization charts, 153
pictures, adding to, 124
resetting document to, 98
for shapes, 204
SmartArt graphics, adding to, 146
for tables, 166-167
templates, 90-91
text boxes, adding to, 204

Quick Tables, inserting, 156
quotation marks, formatting, 226

R
ragged alignment, 76
read-only documents, 338-339

marking, 360
opening, 12

Read Mode view, 16-17.

readability of documents, 289
thesaurus, use of, 300

reading
comments in shared documents, 366
documents, 18-19

Reading Highlights button, 56
Recent Documents or Folders list, 12, 414-

415
recent documents or folders options, 414
Recolor Picture Quick Style gallery, 132-133
recoloring pictures, 132-133
recording macros, 449
Recovered document status, 32
recovering documents, 32-33
redoing actions, 64
reflection effects

pictures, adding to, 127
shapes, adding to, 211
in text, 68-69

relationship graphic type, 142
remove.

Office, 434
repairs. See also troubleshooting

damaged files, opening, 12
diagnosing/repairing problems, 434
maintenance, performing, 434
Office, 434
recovering documents, 32-33

repeating actions, 64
Replace command, 56-57
replacing. See finding and replacing
replacing text as you type, 63
Research pane

options, changing, 249
topics, researching, 248
translating text with, 297

Reset Picture button, 131
resizing

bitmap images, 129
live layout preview, 150, 200-201

options, 410
pictures, 128-129
shapes, 200-201
SmartArt graphic, 150
split windows, 47
tables, cells in, 165
task panes, 10
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Text pane, 144
web pages, 325
window panes, 10
windows, 10, 44

Restore Down button, 44
Restrict Formatting and Editing task 

pane, 340-341
restricting formatting/editing, 340-341
Reveal Formatting pane, 96
reverse page order printing, 417
Reviewing pane, 362-363

comments, working with, 364-367
showing/hiding, 368-369

RGB colors, 101, 104-105
Ribbon, 1, 3, 4. See also Developer tab

accessing commands not on, 430
color options, 101
commands, 5

accessing commands not on, 430
choosing, 6

customizing, 7
display options, 4
maximizing/minimizing, 4, 6

right-alignment
of equations, 262
of objects, 212-213
of text, 76

right indents, 82
Roman numerals for footnotes and end-

notes, 252
rotating. See also 3-D effects

objects, 217
pictures, 134-135
SmartArt graphics shapes, 148-149
WordArt text, 141

round bullets, 84
RTF files, 25

form controls, 458
importing documents as, 382
saving documents as, 393

rulers
measurements, changing, 80
in Print Layout view, 413
showing/hiding, 80

Run dialog box in safe mode, 359

S
Safe for Initialization (SFI) settings, 354
safe mode, 358-359

disabled items, viewing, 359
saturation, 105
Save Address List dialog box, 271
Save As screen, dialog box, 22-24
Save command, 1
Save dialog box

file extensions, displaying, 15
options, accessing, 22

saving, 22-23
advanced save options, setting, 424-425
chart templates, 185
compressing pictures on, 130
Document Management Server, 

documents to, 472
macros, documents with, 456
older Word documents, 23
options, setting, 23
other formats, documents with, 24-25
PDF file, document as, 404
RTF files, documents as, 393
shapes as pictures, 124
Web pages, 324-325
XML documents, 22, 387
XPS file, document as, 405

scaling pictures, 128-129
Schedule, opening, 14
schemas. See XML (Extensible Markup

Language)
Screen shot 

capturing, 122
inserting, 122

ScreenTips
for add-ins, 440
for hyperlinks, 323
for macros, 455
shortcut keys, showing, 413
styles, selecting, 410
for themes, 103
turning on/off, 6

Scroll Bar Button, 462
scroll bars, showing, 413
searching. See also finding and replacing

for exclusion dictionaries, 289-290
for help, 21
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for inconsistent formatting, 287
in long documents, 234
metadata criteria, 428
for themes, 103

sections
breaks, inserting/deleting, 306-307
collapsing, 306-307
expanding, 306-307
navigating in document by, 234-235

security, 333. See also passwords; security
alerts; Trust Center

digital signatures, 342-343
Document Inspector, 334-335
encryption of files, 336-337
for forms, 459
harmful attacks, avoiding, 346-347
restricting formatting/editing, 340-341

security alerts
for ActiveX controls, 461
add-in security alerts, 443
macros, alerts on opening, 457

Select Text with Similar Formatting 
command, 70

selecting. See also objects
footnotes and endnotes, 253
options, 418
similar formatting, text with, 70
style formatting, 96
table elements, 158
text, 50-51

Selection Mode, 9
Selection pane, 51, 220 

selecting objects with, 220
self-signing certificates, creating, 454
Send Backward for objects, 216
Send to Back

for objects, 216
SmartArt graphics shapes, 148-149

Send To Microsoft Word dialog box, 394
Send2FAX, 376
sepia color option, 132
series lines in charts, 182
Set Transparent Color command, 133
setup diagnostics, 434
shading

adding/removing, 192-193
applying, 86-87

shadow effects

pictures, adding to, 127
shape text, adding to, 205
shapes, adding to, 210-211
text, 66, 68
to WordArt, 140

Shadow or 3-D Effects gallery, 68-69, 140
shadow text, 68-69
Shape Effects button, 207
Shape Effects gallery, 210-211
Shape Fill color, 206-207
Shape Outline button, 126
Shape Outline color, 206-207
Shape Quick Style gallery, 204
shapes. See also freeforms; organization

charts; SmartArt graphics
adjusting, 201
applying shapes to pictures, 125
color fills, applying, 206-207, 208
connecting two shapes, 216
customizing creation methods, 431
defined, 187
deleting, 200
drawing, 200
effects, applying, 210-211
fills

color fills, applying, 206-207
gradient fills, applying, 209
picture fills, applying, 208
texture fills, applying, 208

gradient fills, applying, 209
outlines, applying, 207
Quick Styles, 204
replacing, 201
resizing, 200-201
saving shapes as pictures, 124
text and, 202, 205
as text boxes, 202
texture fills, applying, 208
transparency, applying color fill 

with, 207
of WordArt text, 139

SharePoint. See also Office Web Apps
applying picture or texture fills from, 208
accessing from, 474-475
co-authoring documents, 469, 494-495
communicating with Lync, 402-403
connecting to, 468
introduction, 468
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inserting picture from, 120, 208
instant messaging with Lync, 377
mobile devices, 469, 490-491
online meeting with Lync, 400-401
opening from, 472-473
saving to, 26, 472-473
sign-in, 470-471
syncing with, 476-477

sharing. See also importing/exporting; 
sharing documents

OLE (object linking and embedding), 380
sharing documents, 361. See also com-

ments; Review pane; SkyDrive;
SharePoint; tracking changes

balloons
for revisions, 362-363
showing/hiding, 367

comparing documents, 370-371
e-mail, sending for review by, 374-375
Internet fax, sending document by, 376
Show Markup button, showing/hiding

elements with, 362-363
templates, sharing, 372-373
tracking changes, 362-363

Shockwave Flash Object ActiveX 
control, 465

shortcut menus
choosing commands from, 5
objects, grouping, 218

shortcuts
customizing, 7
printing, 312
program shortcuts, 2
ScreenTips, showing in, 413
symbols, assigning to, 265

Show Markup button, 362-363
showing/hiding. See also gridlines; text;

Word Options
balloons, 367
chart elements, 180
Developer tab, 447
document formatting elements, 362-363
Document Inspector viewing hidden

text, 334-335
footnotes and endnotes, 250
grammar errors, 292
Mini-Toolbar, 410
objects, 216

Reviewing pane, 368-369
reviewers, 369
rulers, 80
Show Markup button, elements 

with, 362-363
spelling errors, 292
subdocuments, 225
table gridlines, 160
text, 88
Text pane, 144
white space, 307

side-by-side tables, 156
side-by-side windows, comparing, 46
sidebars

cross references to, 232
Quick Parts for, 244
text boxes for, 198

signature lines, adding, 344-345
signatures. See digital signatures
signing signature line, 345-346
Simple style set, 98
single file Web page, saving document as,

324-325
size. See also resizing

page size options, 43
paper size, setting, 304

Size and Position dialog box, 128
cropping pictures with, 134-135

Size Dialog Box Launcher, 129
shapes, resizing, 200-201

SkyDrive. See also Office Web Apps
applying picture or texture fills from, 208
accessing from, 480-481
adding files to, 480-481, 484
connecting to, 468
copying files or folders, 482-483
creating documents, 485
creating folders, 482-483
deleting files or folders, 482-483
downloading files, 480-481, 484
embedding links, 486-487
inserting picture from, 120, 208, 226
introduction, 468
mobile devices, 469, 490-491
moving files or folders, 482-483
opening from, 472-473
renaming files or folders, 482-483
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saving to, 26, 472-473
sending links, 486-487
sharing documents with, 478-479
sign-in, 470-471
storage space, manage, 481
uploading files, 480-481, 484

SkyDrive Pro. See SharePoint
accessing documents, 474-475
introduction, 432-433, 468-469
using, 476-477

slide presentations, creating, 390-391
slider, 31
small caps text, 68
smart cursoring, 418
SmartArt graphics. See also organization

charts
adding shapes, 148-149
blank graphics, creating, 142-143
changing shapes, 148-149
colors, changing, 147
creating, 142-143
deleting shapes, 145
diagram type, changing, 142
formatting

orientation, changing, 146
Quick Style, adding, 146
shapes, 206
text, 145

graphic layouts, changing, 142, 151
layout, changing, 147
orientation, changing, 146
picture layouts, 142, 151
purposes, list of, 142
Quick Style, adding, 146
resizing, 150
shapes, formatting, 206
text, working with, 145
Text pane

showing/hiding, 144
text, working with, 145
working with, 142-143

Snap to Grid for objects, 212-213
Snap to Shape for objects, 212-213
Social Networks

adding account to Office, 27
sharing with, 478-479, 486-487, 

494-495

soft edges effect
in organization charts, 153
pictures, adding to, 127
shapes, adding to, 211

soft page breaks, 306
software. See also ActiveX controls

antivirus software, 347
sorting

mail merge, records for, 273
table contents or lists, 159

sounds
feedback with, 426

source files, 380, 384
source program, 384
sources, adding, 254-255
spacing

character spacing, changing, 78-79, 420
line spacing, changing, 77
WordArt text spacing, 140

spam, 346
Spanish, translating text to, 296
spell-checking, 288-289

contextual spelling, 292-293
language, 294-295
options, changing, 292-293
Word options, changing, 293
as you type, 288-289

Spin button, 462
splitter, resizing, 10
splitting

cells in tables, 162
windows, 46-47

spoofed Web sites, 346
Spreadsheet Compare, 432
spyware, 346
squares, drawing, 200
stacking order of objects, changing, 216
standard modules in VBA, 445
standard tabs, 4
starting

Mail Merge wizard, 268
Word, 2

Start screen
getting to, 2
opening templates, 113
opening new documents, 36-39
options, 408
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Startup
Default File Locations, 422-423
options, 408

statistics, displaying, 428
Status bar, 3

adding/removing items from, 9
word count statistics, 240

Status Quick Part, 244
Strict Open XML Document format, 12, 22-

23, 24-25
strikethrough

shape text, adding to, 205
text, 66, 68

Style Sets, for documents
applying, 98
creating, 99
reset a style, 99
setting default style, 99

styles. See also Quick Styles; WordArt
character styles, 92
chart styles, changing, 177
clearing formatting, 90-91, 96
comparing text formatting, 97
custom style set, creating, 99
Format Painter, applying with, 100
list of styles, viewing, 93
managing styles, 94-95
modifying styles, 93
new styles, creating, 92
paragraph styles, 92
predefined style sets, 98
previewing, 95
printing, 312
quick styles, applying, 90-91
ScreenTip styles, selecting, 410
selecting formatting, 96
sets, changing, 98-99
table style options, changing, 170

Styles pane, 94
sub procedures, VBA, 445
subdocuments, inserting, 224-225
subscript text, 68
summaries

changing options, 428
superscript text, 68
surface of 3-D effects with shapes, 211
swiping, 429
switching between windows, 45

Symantec antivirus software, 347
Symbol dialog box, 264
symbols

AutoCorrect changes, 63
inserting, 265
mathematical symbols, 262
technical documents, inserting, 264-265

synonyms, finding, 293
syntax for VBA code, 444
system requirements, 2

T
Tab key

indents with, 82-83
objects, selecting, 218

tab leaders. See leaders
tab stops for header/footer text, 229
Table Quick Style gallery, 166
tables, 155

adding contents of columns and 
rows, 171

additional rows or columns, 
inserting, 160-161

aligning text in cells, 164
averaging values in cells, 172
Banded Row or Banded Column 

option, 170
borders, applying, 168-169

painter, 169
clearing formatting, 166
converting back to text, 156
creating, 156-157
creating table styles, 167
custom tables, drawing, 157
decimal percentage, displaying numbers

as, 172
deleting

contents of cell, 158
rows, columns or cells, 161

direction of text, changing, 164
entering text in, 158
even distribution of columns and 

rows, 161
from existing text, 156
fills, applying, 168
floating tables, 156
height of rows, setting, 162-163
margins of cells, changing, 164-165
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merging cells, 162
moving in, 158
navigating in document with, 234-235
nested tables, 156, 165
outlines, applying, 168-169
properties, changing, 163
Quick Styles, adding, 166
Quick Tables, inserting, 156
quickly creating new tables, 157
resizing cells, 165
selecting elements in, 158
showing/hiding gridlines, 160
side-by-side tables, 156
size of cells, changing, 165
slides, Word tables in, 390-391
sorting contents or lists, 159
splitting cells, 162
style options, changing, 170
summing rows and columns, 171
Total Row option for, 170
ungrouping, 218
values, calculating, 172
width of columns, setting, 161, 162-163
wrapping text around, 196-197

tables of contents, 236-237
manually creating, 237

tables of figures, 259
Tablet PC

handwritten comments, inserting, 365
signatures with, 344-345
touch screens, 429
voice comments, inserting, 364

tabs, 3, 4
in dialog boxes, 8
paragraph tabs, setting, 81

tags. See XML (Extensible Markup
Language)

tap, 429
target frame, setting, 320-321
task panes, 10
Taskbar, 413
Tech Support, 20-21
technical documents, 243. See also book-

marks; footnotes and endnotes
AutoText, working with, 246-247
bibliographies, 254
building blocks, working with, 244-245
captions, creating, 258

equations, creating, 262-263
lines, numbering, 260-261
numbering lines in, 260-261
Quick Part building blocks, 

inserting, 244-245
Research pane, working 

with, 248-249
symbols, inserting, 264-265
tables of figures, 259

Telemetry Dashboard, 432
Telemetry Log, 432
templates. See also My Templates; styles

changing, 114
chart templates 

creating and saving, 185
managing, 186

copying functionality between, 372-373
creating, 111-112
Default File Locations, 422-423
defined, 37
Document Information Panel template,

selecting, 466
documents, creating, 37
global templates, loading/unloading, 372
macro-enable templates, 456
opening, 113
password protection for, 373
resetting documents, 98
setting up for, 111
sharing, 372-373

Templates/Charts folder, 185, 186
text. See also foreign languages; format-

ting; printing; tables; text boxes;
themes; WordArt

aligning, 76
AutoCorrect feature, 62-63
AutoText, working with, 246-247
boundaries, showing, 412
case of text, changing, 68
Click-And-Type text, 76
columns, working with, 194-195
comparing text formatting, 97
copying

with Clipboard, 54-55
with drag-and-drop, 53

default text options, changing, 420
deleting, 52-53
drag-and-drop, 52-53
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tteexxtt  ((ccoonnttiinnuueedd))
editing, 52-53
effects

formatting, 68-69
options, 420

equation as text, displaying, 263
finding and replacing, 56-57

as you type, 569
formatting options, 71
header/footer text, tab stops for, 229
hidden text, 68

Document Inspector viewing, 334-335
printing, 416

hyphenation options, 58-59
inserting, 52-53
keyboard corrections, 52
ligatures, 78-79
pasting, 54-55
selecting, 50-51
shapes, adding to, 202, 205
showing/hiding, 88
size, increasing/decreasing, 18
watermarks, 191
wrapping text around object, 196-197

Text Box button, 462
text boxes

with cover pages, 241
defined, 187
in dialog boxes, 8
effects, 68-69
existing text, creating from, 198
inserting, 198
linking, 198-199
Office.com, 198
Quick Styles, adding, 204
shapes as, 202
showing on screen, 412
word count statistics, 240

Text pane. See also SmartArt graphics
resizing, 144

texture fills to shapes, 208
Theme Colors dialog box, 102
Theme Effects button, 108
themes, 102

accent colors, 102
applying, 103
custom colors, creating and 

applying, 104-105

custom themes
choosing, 110
creating, 109

defined, 89
deleting

custom themes, 109
effects, 108
fonts, 108

effects, choosing, 108
fonts, choosing, 106-107
hyperlink colors, 102
searching for, 103
viewing, 103

thesaurus, working with, 300
third-party add-ins. See add-ins
3-D charts, 176-177
3-D effects

in organization charts, 153
pictures, adding to, 127
for shapes, 210-211
for text, 68-69
to WordArt, 140

3-D rotation effect, 211
Thumbnail pane, displaying, 18-19
times. See dates and times
titles

chart titles, changing, 180
in headers or footers, 228
text boxes for, 198

Toggle button, 462
toolbars. See also Quick Access Toolbar

commands, choosing, 6
Tools. See Office Tools 
top-aligning objects, 212-213
Total Row option, 170
touch screens, 429
tracking changes

balloon, showing or hiding, 368
locking, 368
printing documents with track 

changes, 369
reviewing changes, 369
Reviewing pane, showing or hiding, 369
using, 368-369
as you work, 368-369

tracking changes on documents, 362-363
trademark symbols, 78-79
transform, opening document with, 12
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translating text to foreign languages, 296
Translation, 296

keyboard language, 295
languages, 298-299
Mini Translator, 296-297

transparency
pictures, setting for, 132-133
shape color fill with transparency,

adding, 207
trendlines in charts, 182
Trojan Horses, 346-347
troubleshooting

objects, arrangement of, 219
XML file problems, 386-387

TrueType fonts, 67
kerning with, 78-79

Trust Center, 333, 346-347. See also add-ins;
macros; Message Bar; privacy

file block settings, 350-351
protected view, 350-351
safe mode, working in, 358-359
Trusted Publishers, Locations, 348-349
viewing, 348

Trusted documents, 348, 350
Trusted locations setting, 348, 349
Trusted publishers. See also ActiveX 

controls
setting, 348, 349

TuCows, 347
turning on/off ScreenTips, 6
2-D charts, 176-177
Twitter

adding account to Office, 27
sharing with, 478-479, 486-487, 

494-495
two-sided documents, printing, 310
TXT files, 25

U
underlining

long documents, formatting in, 226
shape text, 205
text, 66, 68

undoing
actions, 64
shape changes, 206

up/down bars in charts, 182

updating
automatic links, 426
Automatic Updates, 347
diagnostics, 434
links, 385
Office, with Windows 8, 434
printing, updating before, 416
table of contents, 236

Upload Center, 432-433
unpinning with Recent Documents or

Folders list, 12-13, 414-415
uppercase text, 68
URLs (Uniform Resource Locators), 317
User-Initiated Safe mode, 358-359
USPS bulk mailing, sorting records for, 273

V
VBA (Visual Basic for Applications), 435.

See also macros; Visual Basic Editor
ActiveX controls, adding code to, 464
building projects, 445
function procedures, 445
harmful attacks and, 346-347
introduction to, 444-445
modules, working with, 445
procedures, 445
sub procedures, 445
writing code, 444

vector images, 116
vertical ruler, 80
video 

inserting or embedding, 154
playing, 465
searching online for, 154

view buttons, 3
Vimeo

inserting video from, 154
viruses, avoiding, 346-347
Visio Professional, 469
Visual Basic Editor, 445-446

Modules window, 445-446
Object Browser, 445-446
Project Explorer, 445-446
viewing, 446

VML (Vector Markup Language), 326
voice comments, inserting, 364
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W
washout color option, 132
watermarks, 190-191
web addresses, 317
Web Layout view, 16-17
web pages. See also blogs; hyperlinks

appearance, changing, 315
browser, opening document in, 315
frames, 320-321
opening documents as, 314-315
options, changing, 326
previewing, 316-317
resizing, 325
saving document as, 324-325
single file web page, saving document

as, 324-325
table of contents, links to, 236

white space
gutters with, 233, 302-303
page display options, setting, 411
showing/hiding, 307

Widow/Orphan control option, 305
widows, 305
width of columns, setting, 161, 162-163
Wikipedia app for Office, 436
wildcards, finding and replacing with, 75
Windows 8

Updating Office, 434
windows

arranging, 45
display, changing, 45
moving, 44
panes, resizing, 10
resizing, 10, 44
side-by-side, comparing, 46
splitting, 46-47
switching between, 45
viewing, 3

Windows Explorer
documents, opening, 2
starting Word from, 2

Windows Firewall, 347
Windows Live. See SkyDrive
Windows Mobile, 469
Windows Write, opening, 14
Word add-ins. See add-ins

Word Count button, 240
word count statistics, 240
Word-Macro-Enabled Documents, 456
Word-Macro-Enabled Templates, 112, 456
Word 97-2003 Templates, 112
Word Options. See also printing

add-in dialog box, opening, 442
Advanced pane options, 412-413
App Catalog security options, 353
compatibility options, setting, 427
default file locations, 422-423
display options, changing, 413
editing options, 418-419
editing options, changing, 286
feedback options, 426
formatting options, 71
General pane, 447
Hidden Text option, 88
Office options, 409
page display options, setting, 411
readability of documents, checking, 289
recent documents or folders, 414-415
Save pane, 424-425
tracking changes, 362-363

Word Templates, 112
Word XML schema, 386-387
WordArt, 115

converting text to, 137
direction of text, changing, 141
editing text, 137
effects, applying, 140
existing text, apply different style to, 138
fills, applying, 138-139
formatting text, 138-139
inserting, 137
rotating text, 141
shapes of text, 139
spacing, changing, 140

WordArt Quick Style gallery, 137
WordArt Styles group, 138
WordPerfect

compatibility options, setting, 427
opening, 14

words, selecting, 50-51
workbook (Excel)

Office Web App, creating, 469, 485, 490
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worms, 346-347
wrapping text

around object, 196-197
forcing text wrapping, 306
showing wrapped text, 412

X
XLStart folder, 448
XML Expansion Pack, 441
XML (Extensible Markup Language), 25, 379

associating XML transformation with
schema, 386-387

attaching/separating schemas, 386-387
Document Inspector viewing, 334-335
editing data files, 386-387
importing documents as, 386-387
inserting XML data, 386-387
opening XML data files, 386-387
options, changing, 386-387
printing tags, 417

saving documents in, 22, 387
XML Transformations file (XSLT), 386-387
XPS (XML Paper Specification) files, 25

document as XPS file, sending, 374-375
saving document as, 405

Y
YouTube

inserting video from, 154
inserting pictures from, 118-119

Z
zip codes

mailing labels, 284
sorts letters by, 273

zip package, 459
zooming, 31

controls, 3
in Print Preview, 308
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